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Easy Appliqué with 5D™ Embroidery Extra, 5D™ Stitch 
Editor, and 5D™ Design Creator 
Janie Lantz 

 

Appliqué is a wonderfully traditional and creative 
technique, and a great way to use up small swatches of 
fabric from other projects.  Learn a couple of unique styles 
of appliqué using 5D™ Embroidery Extra’s ExpressDesign 
Wizard, 5D™ Stitch Editor’s Modify tab, and 5D™ Design 
Creator’s more sophisticated designing capability! 

 

 
 

Reset All Modules 

1. Open 5D™ Embroidery .  

2. QuickLink to 5D™ Configure . 

3. Click on Reset All Modules.  

4. Click OK to the message, ‘All modules will be closed and reset to their default 
settings’. 

5. When you see the message, ‘Please confirm that all modules except 5D™ Configure 
are now closed’, ensure no other modules are open in the background.  If they are, 
click on the module(s) in the background, and close after saving any work that might 
be in progress.  Click OK to the ‘All modules will be closed’ message when you have 
verified all other modules are closed. 

6. Click OK to the message, ‘All modules are now reset to their default settings’.   

Resetting the Modules will make all menus appear as they first installed, reset all 
browse windows to their default size and folder, and make the Control panels and 
toolbars reset to default.  No changes will be made in custom settings such as 
MyThreads, MyMachines, or MyHoops. 

7. Click OK to close 5D™ Configure.  
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Part 1:  Quick Appliqué in 5D™ Embroidery Extra 

8. Open the Desktop icon .  From the Program Folder, open 5D™ Embroidery . 

9. You may see the message, Please Wait, Configuring the 
software for the current user.   

The 5D™ Embroidery System is setting up the file structure for 
your version of 5D™ Embroidery Software.   

10. Click Hoop .  In Hoop Group, select PFAFF® creative 
sensation™.  In Hoop Size, select the 120mm x 120mm – 
creative™ 120 Square Hoop, Orientation Vertical.  Click OK to Hoop Selection. 

11. Click the ExpressDesign Wizard icon .  The Express Design Wizard – Choose 
Design Type will open. 

The ExpressDesign Wizard icon also has a drop down menu 
attached.   

When you click the main icon, the ExpressDesign Wizard will 
open.  This wizard creates an embroidery that will be as large 
as will fit in the hoop. 

If you click the drop down menu button attached to the icon, 

you can select either ExpressDesign Wizard  to fill the 

entire hoop, or Fit to Hoop , which requires click and drag 
to box an area into which your design will fit. 

12. Select Create Express Border.   

Note the ‘I’ for information at the bottom of the Wizard.  ‘Create Running Stitch, Motif, 
Satin Border or Appliqué around enclosed areas in the picture.’ 

13. Click Next. 

14. In ExpressDesign Wizard – Choose Picture, click View Picture .   

If desired, click and drag the lower right corner of the Picture Viewer 
window to enlarge your view and see bigger Thumbnails! 

15. Browse  to documents\ 5dembroidery \samples \5demb \pics2 
\toys. Click OK to view the Thumbnails. 

16. Click to select 1CTo001.png, a teddy bear.  The graphic will 
automatically load into the Wizard. 

If you hold the cursor over a Thumbnail, the name will appear as a pop-up. 

17. Click Next. 
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18. In ExpressDesign Wizard – Rotate Picture, the teddy bear is rotated at about a 45○ 
angle.  We need to make him ‘square’ with the hoop to maximize his size in the 
selected hoop. 

Click and hold on one of the two small arrows by Rotation Degrees 
to rotate the graphic until the bear’s feet are about aligned with the 
horizontal bottom of the select box, somewhere around 325○.   

The arrow pointing up will rotate clockwise, and the arrow pointing 
down will rotate counter-clockwise. 

19. Click Next. 

20. The ExpressDesign Wizard - Monochrome Threshold finds the 
clearly defined outlines in the artwork and reduces the image to black and white.   

If larger areas in the artwork still have black fill, adjust the slider bar until only black 
outlines remain on a white ground.  Occasionally, you cannot remove all the filled 
areas.  When creating Express Borders, the Wizard will use only the outermost 
outline, so inner areas aren’t critical. 

21. Click Next. 

22. In ExpressDesign Wizard – Crop Picture, a crop box will automatically surround 
the artwork, cropping away any excess background.  Though you can adjust the box 
using the square corner handles, or by clicking and dragging the dotted lines defining 
the box, we don’t need to adjust the Crop Box. 

23. Click Next. 

24. In ExpressDesign Wizard – Express Border Options, choices 
include different styles of embroidery options.  All Border Type 
functions will create stitches only around outermost outlines of 
individual elements.  For the teddy bear, the outer body outline 
will define the final embroidery stitches. 

 
25. Select Appliqué in Border Type.  Click Options. 

26. Change Satin Density to 4.   

The lower the Density number, the closer the stitches 
for greater density. 

27. Change Satin Width to 3.5 mm.   

The width of satin stitches is a personal choice, but 
narrower settings sometimes don’t catch the edge of 
the appliqué well, and the fabric can pull out.   

Wider settings can produce awkward overlaps at sharp or tight corners. 

28. Ensure Underlay is checked. 



 

Page | 4  

©2012 KSIN Luxembourg ll, S.ar.I. CREATIVE, CREATIVE SENSATION, 5D, and PFAFF  are exclusive trademarks of KSIN 
Luxembourg ll, S.ar.I.  All rights reserved.        

 

29. Select Running Stitch – Stop – Double Stitch – Stop – Satin in Method.   

The extra Running Stitch allows you to mark where you’ll lay your appliqué fabric, so 
you can cut a smaller fabric swatch for economical appliqué! 

30. After you select the second Method for Appliqué, you’ll see the Running Stitch 
Length option activate.  Change both Running Stitch Length and Double Stitch 
Length to 1.5mm.   

A shorter stitch length will attach the appliqué fabric more securely and strengthen 
the area where the fabric patch will be attached. 

31. Click OK to the Appliqué Options. 

32. Click Thread Color .  Select Show All Thread Ranges.  Browse to the thread 
brand of your choice, and select your favorite color.   

33. Click OK to Color Selection. 

34. Click Next. 

35. The ExpressDesign Wizard – Design Preview page shows a three-dimensional 
preview of the finished appliqué, along with design information 
such as the number of stitches and design size. 

36. Click Finish. 

 
37. The embroidery will be placed within the hoop, as indicated by 

square corners on the select box.  Notice it completely fills the 
height of the hoop. 

Although you can Rotate , Flip Horizontal  or Flip Vertical , Resize  or drag 
a corner box to Rescale, and can also edit stitch points in the Edit tab, the design 
stitches are otherwise fixed at this point.  All editing will require some investment of 
your time! 

38. Click Save As .  In Save In, browse to the folder of your choice.  Type 
AppliquéTeddy in File Name.  Select .vp3 as the Save As Type, to ensure you 
save the Settings and any Notes you may have added, as well as your personally 
selected threads.  Click Save.   

39. Select File/ Page Setup, and 
set as shown to print an 
overview of the embroidery, 
plus individual worksheets.  If 
you want the individual 
worksheets to be real-size 
templates, choose 100% for 
Design Scale. 

40. Click OK. 
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41. Select File / Print to print your pages. 

42. If you need a different embroidery format for your personal 
machine, click Save As again and change the Save As 
Type to your preferred format.   

Saving in some formats may result in loss of information 
for thread type or Notes/Settings, depending on your 
preferred file type / brand, due to differing manufacturer’s 
machine properties.   

Always save first as a .vp3 format, and then print the 
template from a .vp3 file type to retain the original thread 
brands and Notes/Settings as a guide while stitching your 
embroidery. 
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Part 2:  Create an Appliqué Patch from an Existing Embroidery 

1. QuickLink to 5D™ Stitch Editor . 

2. Click View Designs .  Browse to Documents\5DEmbroidery 
\Samples \5DEmb \Stitch2 \Toys.  Click OK to view the 
Thumbnails. 

3. Click Page Down  once.  Click to select 

Teddy_Bear_Toy_Boat.vp3.  Click Close Viewer . 

4. Click Hoop .  Change the Hoop Group to PFAFF® creative 
sensation™.  Change the Hoop Size to the 200mm x 200mm – 
creative™ Quilter’s Hoop, Orientation Vertical.   

5. Click OK to Hoop Selection.   

Notice the design automatically centers in the hoop! 

6. Select the Modify tab in the Control Panel. 

7. In the Border / Appliqué toolbar, click Draw Border Shape .  
From the Shape drop down menu, select Shape 15, a star. 

8. Click and drag a box around the embroidery design, and then 
release the mouse cursor.  A select box will appear with a moving 
highlight of the star showing where the appliqué stitches will be 
placed.   

9. Adjust the select box so the moving highlight is surrounding the 
embroidery design.  Click and drag any corner handle to adjust the select box size.  
Hold down the CTRL keyboard key to maintain the original proportions.   

The select box may sit outside the Design Area of the hoop, but the finished 
embroidery cannot be larger overall than the hoop in which you plan to stitch.  Be 
careful to keep the select box small enough to fit within one of your embroidery 
hoops. 

An easy way to check whether the finished Border Appliqué will fit in the selected 
hoop is to place the cursor inside the select box, then click and drag it until all four 
corners are inside the Work Area of the hoop.  If you cannot get all four corners in 
the Work Area, your Appliqué will be too large for the hoop. 

Remember, you must also allow for the width of the satin stitches outside the moving 
highlight! 

10. The star shape does not fit well around the embroidery design we selected.  Right 
click to end the select box without creating the Border Appliqué. 

11. Select Shape 16, an eight point star.   

12. Click Draw Border Shape .   
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13. Click and drag a select box.  Click and drag the corner handles to adjust the select 
box until it fits around the embroidery design.  Click inside the select box and drag to 
adjust the placement of the box.  

You may also Flip Horizontal  or Flip Vertical , or Rotate  using the handles 
on the select box. 

14. When the moving highlight is adjusted to your liking, click Preferences .  Select 
the Border tab.   

15. In Satin Border, adjust Width to 3.5mm, Stitch Density to 4, Thread Color  to 
your choice, and a check in Underlay.   

16. In Appliqué Placement, select the Running 
Stitch – Stop – Double Stitch – Stop – Satin, 
and adjust both Stitch Lengths to 1.5mm for 
more strength. 

17. Click OK to Preferences. 

18. Click the drop down menu tab attached to Create Appliqué  to 

open the menu.  Select Create External Appliqué  to crop away 
any part of the embroidery that sits outside the moving 
highlight in the crop box, and retain all stitches inside the 
moving highlight. 

Click Help in the Control Panel if you want to learn more 
about Create Internal Appliqué or Create Overlay Appliqué. 

19. Notice you now have two program windows open, indicated by the tabs at lower left 
of the Work Area.  The first tab is the original embroidery design.   

The second tab is named with a ‘_b’ at the end of the original file name, indicating it 
is a second (b) design made from the first! 

20. While in the (b) design tab, click Save As .  In Save In, browse to the folder of 
your choice.  In File Name, type TeddyBorderApplique.  Select .vp3 in Save As 
Type.  Click Save. 

21. Select File / Print to print templates and an overview guide. 

If you use another embroidery format for your personal machine, click Save As and 
save in your preferred format. 

22. Select the Design tab in the Control Panel.  Hold the cursor over the first thread 
color in Color Select.  The tack-down line for the appliqué will appear highlighted in 
the Work Area of the hoop.  This color is first in stitch order, which indicates you will 
tack down the fabric before stitching the colors in the embroidery design. 

23. Scroll to the bottom of the Color Select box.  Hold the cursor over the last thread 
color in Color Select.  The satin stitches for the Appliqué border will highlight in the 
Work Area, indicating they stitch last in the embroidery design. 
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24. 5D™ Stitch Editor intelligently sequences the embroidery so the appliqué fabric is 
placed UNDER the embroidery design, but the satin border is placed to stitch over 
everything else, creating a nice finish to your appliqué! 

Quickly and easily create Appliqués and Borders with existing embroidery designs in 
5D™ Stitch Editor!  Use all 5D™ Stitch Editor’s tools to make additional modifications 
in your appliqué (and any other) embroideries! 
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Part 3:  Create Appliqué in 5D™ Design Creator 

1. QuickLink to 5D™ Design Creator . 

2. In ExpressDesign Wizard – Choose Design Type, select Create Express Border.  
Click Next. 

3. Click View Picture .  Browse  to documents\ 5dembroidery \samples 
\5demb \pics2 \toys. Click OK to view the Thumbnails. 

4. Click to select 1CTo001.png, a teddy bear.  Click Next. 

5. In ExpressDesign Wizard – Rotate Picture, click and hold on one of the two small 
arrows by Rotation Degrees to rotate the graphic until the bear’s feet are about 
aligned with the horizontal bottom of the select box, somewhere 
around 325○.   

6. Click Next. 

7. The ExpressDesign Wizard - Monochrome Threshold finds the 
clearly defined outlines in the artwork and reduces the image to black 
and white.   

8. If larger areas in the artwork still have black fill, adjust the slider bar 
until only black outlines remain on a white ground.  Occasionally, you 
cannot remove all the filled areas.  When creating Express Borders, the Wizard will 
use only the outermost outline, so inner areas aren’t critical. 

9. Click Next. 

10. In ExpressDesign Wizard – Crop Picture, a crop box will automatically surround 
the artwork, cropping away any excess background.  Though you can adjust the box 
using the square corner handles, or by clicking and dragging the dotted lines defining 
the box, we don’t need to adjust the Crop Box. 

11. Click Next. 

12. In ExpressDesign Wizard – Design Size, select Fit Design to Hoop.  Click 
Change Hoop. 

13. In Hoop Group, select PFAFF® creative sensation™.  In Hoop Size, select the 
120mm x 120mm – creative™ 120 Square Hoop, Orientation Vertical.   

14. Click OK to Hoop Selection. 

15. Click Next. 

16. In ExpressDesign Wizard – Express Border 
Options, select Appliqué in Border Type.  Click 
Options. 

17. Change Satin Density to 4.   

18. Change Satin Width to 3.5 mm.   

19. Ensure Underlay is checked. 

20. Select Running Stitch – Stop – Double Stitch – Stop – Satin in Method.   
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21. Change both Running Stitch Length and Double Stitch Length to 1.5mm.   

22. Click OK to the Appliqué Options. 

23. Click Thread Color .  Select Show All Thread Ranges.  Browse to the thread 
brand of your choice, and select your favorite color.   

24. Click OK to Color Selection. 

25. Click Next. 

26. Click Finish. 

27. Select the Edit tab.  Here, though the design is very similar to the ExpressDesign 
Wizard in 5D™ Embroidery Extra, you can see the elements used to create this 
simple appliqué. 

28. Click Save As .  In Save In, browse to the folder of your choice.  In File Name, 
type b.  In Save As Type, the file type is .can.   

A .can file is the working file for 5D™ Design Creator, and allows you to later open 
and edit the design and maintain the original integrity of all stitch areas!   

29. Click Save. 

30. Click Save Embroidery .  Browse to the folder of your choice.  The name will 
already appear, since you saved the .can file first.  Ensure the Save As Type is 
.vp3.  Click Save. 

31. If required, click Save Embroidery to save an additional file format for your personal 
embroidery machine. 

 
Let’s jazz up our bear a little bit! 
32. Select the Edit tab.  The FilmStrip shows all the objects that make up our 

embroidery.   

33. The Running Stitch is a marker stitch to define where to place the fabric.  The 

following Stop  tells the embroidery machine to stop temporarily while we add 
the appliqué fabric. 

34. The Double Stitch attached the appliqué fabric.  The following Stop  tells the 
embroidery machine to stop temporarily while we trim the excess appliqué fabric. 

35. The Satin Line is the ‘finish’ for the raw edge of the appliqué fabric.   

36. Click on the frame in the FilmStrip with the Satin Line object to select it.   

37. Select the Create tab, so we are viewing the design in a real life, three dimensional 
view. 

38. Right click over the Work Area. 
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39. In the Area box, click the drop down menu by No Fill  and select 

Motif Fill .  Click on the title bar and move it so you can see the 
bear’s body.   

40. Select Universal for the Group.  Change the Category to 
Candlewicking 1.  Select Pattern 1.  Click Apply. 

The bear will now have a fairly dense candlewick texture! 

41. Select the Spacing tab in the Area box.  Change Horizontal Gap 
to 50%, and Vertical Gap to 75%.  Click Apply to see the 
change. 

42. Change Horizontal Offset to 50%, and leave Vertical Offset at 
0.  Click Apply. 

43. This is a nice texture for bear fur!  Click OK to close the Area box. 

44. Click Save As .  In Save In, browse to the folder of your 
choice.  In File Name, type AppBearTextureDesCr.  In Save As Type, the file type 
is .can.  A .can file is the working file for 5D™ Design Creator, and allows you to later 
open and edit the design and maintain the original integrity of all stitch areas!  Click 
Save. 

45. Click Save Embroidery .  Browse to the folder of your choice.  The name will 
already appear, since you saved the .can file first.  Ensure the Save As Type is 
.vp3.  Click Save. 

If your design is just a bit too large to save due to the satin stitches around the 
border, click cancel. 

Click Hoop .  Select Enter Size. 

Change both Width and Height to 110mm and click OK.   

You will be asked if you want to resize to fit the new hoop size.  Click Yes. 

Click Hoop.  Uncheck Enter Size.  Select the 120mm x 120mm – creative™ 120 
Square Hoop, Orientation Vertical.  Click OK. 

You will be asked if you want to resize the embroidery to fit the new hoop.  Click No, 
so the design will stay at its slightly smaller size! 

Now, click Save As , and re-save the .can file.  Then click Save Embroidery  
and save the finished design. 

46. If required, click Save Embroidery to save an additional file format for your personal 
embroidery machine. 

 

Appliqué is so easy and yet so creative in 5D™ Embroidery Software! 


